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ABSTRACT 

Title      :  Monitoring of cotton croplands in Odisha using Geospatial tools 

Name     :   Pragada Tanuja and Gudla Varun 

Institute         :  Centurion University of Technology and Management, Paralakhemundi, 

Odisha, India 

Supervisor     :   Gumma Murali Krishna 

Submitted     :   01
st
 May, 2017 

Agriculture is the backbone of our Indian economy and the crucial sector for ensuring 

food security. Timely availability of information on agriculture is vital for taking informed 

decisions on food security issues. India is one of the few countries in the world that uses 

space technology and land-based observations for generating regular updates on crop 

production statistics and providing inputs to achieve sustainable agriculture. For proper 

planning and efficient utilization of the land and water, it is necessary to understand the crop 

period, necessary types of crops to be cultivated in the suitable areas and hydrological cycle. 

The reliable prediction of crop and hydrological parameters for remote and inaccessible areas 

is tedious and time consuming by conventional or traditional methods. As the technology is 

improving in the field of agriculture it became easy for off and on farm activities. Use of 

mathematical models for extracting the crop characteristics using Remote sensing and 

Geographical Information System (GIS) with high speed computers is aiding tools and 

techniques for it. As the part of the technology, Geospatial tools play a vital role in the field 

of agriculture. 

In the present study, MRT2011 (MODIS Reprojection Tool, Version 4.1), was developed to 

support higher level MODIS Land products which are distributed as Hierarchical Data 

Format (.hdf) -Earth Observing System (HDF-EOS) files projected to a tile-based Sinusoidal 

grid(.tif). This software was applied to districts of Odisha (Rayagada, Kalahandi and 

Balangir) and extracted the NDVI (Normalized Difference Vegetative Index). This helps in 

identification of Crop area and other vegetative indices. Then the classification of LULC 

(Land use/land cover) is done using the ERDAS Imagine2014 (ver.14.00). 

To study the diversification of crops, we need to collect the data and analysis has been done 

taking into consideration of major crop of the study area like Rice. Our study mainly focuses 

on how Cotton replaces Rice in some parts of study area (i.e., from 2002-2014 is 29000ha to 

135000ha) due to lack of irrigation facilities and unproductive soils with low yields. By 

taking the data of 2013-14 and carried out the classification using above software. This result 

shows the amount of area affected to crop diversification. 

(Keywords: Remote Sensing, GIS, MODIS Reprojection Tool, ERDAS Imagine, Land 

use/Land cover, NDVI) 
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CHAPTER 1 

INTRODUCTION 

Agriculture is the backbone of Indian economy and the crucial sector for ensuring food security. 

Timely availability of information on agriculture is vital for taking informed decisions on food 

security issues. India is one of the few countries in the world that uses space technology and 

land-based observations for generating regular updates on crop production statistics and 

providing inputs to achieve sustainable agriculture. Satellite-based optical and radar imagery are 

used widely in monitoring agriculture. Radar imagery is especially used during monsoon season. 

Integrated use of geospatial tools with crop models and in- situ observation network enables 

timely crop production forecasts and drought assessment & monitoring. 

For proper planning and efficient utilization of the land, it is necessary to understand the crop 

period, necessary types of crops to be cultivated in the suitable areas. The reliable prediction of 

crop for remote and inaccessible areas is tedious and time consuming by conventional or 

traditional methods. As the technology is improving in the field of agriculture it became easy for 

off and on farm activities. Use of mathematical models for extracting the crop characteristics 

using Remote sensing and Geographical Information System (GIS) with high speed computers is 

aiding tools and techniques for it. 

In Odisha, Rice is the principal food crop occupying about 44.55 lakh ha annually (41.24 lakh ha 

in Kharif season + 3.31 lakh ha. in Rabi season). The entire Rabi area is irrigated & covered by 

high yield Paddy where as 36% of Kharif Paddy area is covered under irrigation. The rice 

production reached the record level of 76.55 lakh tones during 2007-08 and at present is 69.16 

lakh tones (during 2008). The yield rate of rice is 1.6 tonnes/ha as against national average of 2.2 

tonnes/ha. Due to lower production in the yields, farmers are diverting to income generating 

crops. The unproductive areas of rice are diversifying into commercial crops like Cotton, 

Jatropha and Oilseeds etc. 

Presently, the commercial mode of agriculture has been rapidly spreading in which farmers will 

easily benefitted by good amount of money. But the right path of cultivation will be achieved by 

better cultivation practices, suitable soil and climatic conditions for the crops. Major commercial 

crops are Cotton, Sugarcane, Tobacco, Jute and Oilseeds etc. which are growing in larger areas. 

Proper planning prior cultivation should be taken which can be obtained by taking the help of 

geospatial tools. 

Presently, the major commercial crop in Odisha is cotton. In this study, we have discussed about 

the scenario of cotton and its expansion towards unproductive rice fields. Though the 

contribution of Odisha towards India’s total cotton production is barely 0.5%, the cotton 

produced in the state is of exportable quality. 
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1.1 Role of Remote Sensing in the field of Agriculture: 

 

A major problem in the Agriculture is the inadequate field measured data to describe the process. 

Remote Sensing has been identified as a tool to produce information in spatial and temporal 

domain, instead of point measurement, in digital form, with high resolution. The remotely sensed 

data acquired from space borne platforms, owing to its wide synoptivity and multi spectral 

acquisition provides spatial information about the various processes of the crop land. This spatial 

information can be used as input data for crop models. Remote Sensing techniques can produce 

high spatial coverage of important terms for large areas, but at the cost of a rather sparse 

temporal resolution. 

Applications of remote sensing techniques: 

1. Agriculture. 

2. Forestry. 

3. Water resources. 

4. Detection of water pollution. 

5. Geology and mineral sources. 

6. Mapping of land use / land cover. 

7. Monitoring of environmental hazards. 

8. Weather and climatic related applications. 

9. Engineering applications. 

10. Human induced geological hazards. 

Applications of remote sensing in agriculture: 

1. Crop identification. 

2. Crop diversification. 

3. Yield estimation and prediction. 

4. Crop acreage estimation 

5. Crop condition assessment and stress detection. 

6. Identification of planting and harvesting dates. 

7. Crop yield modeling and estimation. 

8. Soil moisture estimation. 

9. Irrigation monitoring and management. 

10. Soil mapping. 

11. Monitoring of droughts. 

12. Identification of pest and disease infestation. 

13. Land cover and land degradation mapping. 

14. Identification of problematic soils. 
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Problems of remote sensing for Indian conditions: 

1. Small size of plots. 

2. Diversity of crops sown in a particular area. 

3. Variability of sowing and harvesting dates in different fields. 

4. Inter cropping and mixed cropping practices. 

5. Extensive cloud cover during the rainy season. 

1.2 Role of GIS in the field of agriculture: 

The use of remote sensing technology involves large amount of spatial data management and 

requires an efficient system to handle such data. Hence Geographic Information System makes it 

possible to store, analyze and retrieve data for large and complex problems. 

What is GIS? 

Geographical Information System (GIS) is a computer based system designed tool applied to 

geographical data for integration, collection, storing, retrieving, transforming and displaying 

spatial data for solving complex planning and management problems. This tool focuses on 

proper integration of user and machine for providing spatial information to support operations, 

management, analysis and decision making. 

Uses of GIS in Agriculture: 

Droughts, floods, group of insects and poor farming techniques have affected the agricultural 

community for centuries. Improvements have been made to insure the safety and gain of crops 

worldwide and yet these factors and many more continue to make or break individuals and 

communities affected by them. 

Geographic Information Systems are incredibly helpful in being able to map and project current 

and future fluctuations in precipitation, temperature, crop output, and more. By mapping work 

together to create more effective and efficient farming techniques; this could increase food 

production in parts of the world that are struggling to produce enough for the people around 

them. GIS can analyze soil data combined with historical farming practices to determine what 

the best crops to plant, are where they should go, and how to maintain soil nutrition levels to best 

benefit the plants. 

Agricultural Geographic Information Systems (AGIS) can map not only topography and crop 

health, but help solve wider economic issues in municipalities and urban centers that may stem 

from rural farming practices. The future implications of AGIS are great and immense in scope. 

With the penetration of technology in the global culture today it is possible that in a few years 

GIS could be available to rural farmers in the developing world to better help them grow crops, 

feed their families, and produce enough food to ship to neighboring areas. Farmers in severe-

weather prone areas (like flood plains or drought zones) would be able to predict what this 
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weather could do to crops, could move fields to better geographic locations, and know how to 

irrigate based on local water resources and weather patterns. The world food crisis could be 

alleviated using GIS. 

 

1.3 Software Used: 

MRT 2011 (MODIS Reprojection Tool, Version 4.1), used it was developed to support higher 

level MODIS Land products which are distributed as Hierarchical Data Format (.hdf) -Earth 

Observing System (HDF-EOS) files projected to a tile-based Sinusoidal grid(.tif). This software 

was applied to districts of Odisha (Rayagada, Kalahandi and Balangir) and extracted the NDVI 

(Normalized Difference Vegetative Index). This helps in identification of Crop area and other 

vegetative indices. Arc GIS (Ver.10.2.2) used for creating the shape file (.shp). Then the 

classification of LULC (Land use/land cover) is done using the ERDAS Imagine2014 

(ver.14.00). 

1.4 Sensors: 

MODIS (or Moderate Resolution Imaging Spectro radiometer) is a key instrument aboard the 

Terra (originally known as EOS AM-1) and Aqua (originally known as EOS PM-1) satellites. 

Terra's orbit around the Earth is timed so that it passes from north to south across the equator in 

the morning, while Aqua passes south to north over the equator in the afternoon. Terra MODIS 

and Aqua MODIS are viewing the entire Earth's surface every 1 to 2 days, acquiring data in 36 

spectral bands, or groups of wavelengths. These data will improve our understanding of global 

dynamics and processes occurring on the land, in the oceans, and in the lower atmosphere. 

MODIS is playing a vital role in the development of validated, global, interactive Earth system 

models able to predict global change accurately enough to assist policy makers in making sound 

decisions concerning the protection of our environment. 

Specifications of MODIS are: 

 Orbit: 705 km, 10:30 a.m. descending node (Terra) or 1:30 p.m. ascending node (Aqua), 

sun- synchronous, near-polar, circular 

 Scan Rate: 20.3 rpm, cross track 

 Swath Dimensions: 2330 km (cross track) by 10 km (along track at nadir) 

 Telescope: 17.78 cm diam. off-axis, afocal (collimated), with intermediate field stop 

 Size: 1.0 x 1.6 x 1.0 m 

 Weight: 228.7 kg 

 Power: 162.5 W (single orbit average) 

 Data Rate: 10.6 mbps (peak daytime); 6.1 mbps (orbital average) 

 Quantization: 12 bits 

 Spatial Resolution: 250 m (bands 1-2), 500 m (bands 3-7), 1000 m (bands 8-36) Design 

Life: 6 years 
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Primary Use Band Bandwidth
1
 Spectral 

Radiance
2
 

Required SNR
3
 

Land/Cloud/Aerosols 

Boundaries 

1 620 – 670nm 21.8 128 

2 841 – 876nm 24.7 201 

 

 Table 1 : MODIS Bands for 250m 

1 Bands 1 to 2 are in nm. 

2 Spectral radiance values are (W/m
2
 -µm-sr). 

3 SNR = Signal-to-noise ratio 

Source: https://modis.gsfc.nasa.gov/about/specifications.php 

1.5 Rationale of the study: 

          The three districts of ODISHA namely RAYAGADA, KALAHANDI and BALANGIR 

have selected for our study purpose are mainly Rainfed. Our study mainly focuses on how cotton 

replaces rice in some parts of study area (i.e., from 2002-2014 is 29000ha to 135000ha). A work 

was formulated to study the changes in the crop pattern within the districts using remote sensing 

data. 

The Specific objectives of the present study are: 

 Case study on the Crop Diversification in the concerned districts 

 Extraction of land use/ land cover information of the study area using Remote Sensing 

and GIS 

 Showing the Diversified area using Geo Spatial Tools 
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CHAPTER 2 

STUDY AREA 

The area which we have selected for the project in Odisha districts namely Balangir, Kalahandi 

and Rayagada. These are the major cotton growing areas. We have studied the scenario of 

cotton in Odisha as it’s a new entrant into the commercial agriculture and rapidly progressing in 

the suitable conditions of the state. The study shows how the cotton areas in Odisha increased 

from the early 90’s to till now with the help of Geospatial tools i.e. Remote sensing and GIS. The 

tools will help for planning or further spreading of the cotton areas in the state. Here we 

explained about the successful cotton growth in Odisha and the type of farming. 

 

                           

Figure 1: Major Cotton growing districts of Odisha 

2.1 Status of Cotton area, production and yield: 

            Over the years, country has achieved significant quantitative increase in cotton 

production. Till 1970s, country used to import massive quantities of cotton in the range of 8.00 

to 9.00 lakh bales per annum. However, after Government launched special schemes like 

intensive cotton production programmes through successive five-year plans, that cotton 

production received the necessary impetus through increase in area and sowing of Hybrid 

varieties around mid-70s. Since then country has become self-sufficient in cotton production 

barring few years in the late 90s and early 20s when large quantities of cotton had to be imported 

due to lower crop production and increasing cotton requirements of the domestic textile industry. 
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Since launch of "Technology Mission on Cotton" by Government of India in February 2000 

significant achievements have been made in increasing yield and production through 

development of high yielding varieties, appropriate transfer of technology, better farm 

management practices, increased area under cultivation of Bt cotton hybrids etc. All these 

developments have resulted into a turnaround in cotton production in the country since last 6/7 

years. The yield per hectare which was stagnant at about 300 kg/ha for so many years, jumped to 

472 kgs in the year 2005-06 and now it reached to the level of 504 kgs to 566 kgs per hectare. 

Though this per hectare yield is still lower against the world average of about 705 Kgs to 805 kgs 

per hectare, country is expected to make more strides in cotton production in the years to come. 

The fundamental changes that taking place in the realm of cotton cultivation in the country, are 

having the potential to take the current productivity level near to the world average soon. 

2.2 Overview of Odisha 

 

   

Source: Status of Agriculture in Odisha 2014-15 

Figure 2: Overview of Odisha 

 

2.3 Scenario of Cotton in Odisha: 
Odisha has one of the richest traditions of handloom and handicrafts in the country, which goes 

back to the time of antiquity. Apart from that, handloom and handicrafts products of Odisha are 

appreciated all over the country and outside because of exquisite designs, natural motifs and 

superb color combination. The state is purely depending on handloom in the textile sector and 

58.13 

3.42 
4.94 

3.75 

12.98 
8.4 

7.56 
2.29 

54.24 

Geographical area: 155.71 lakh ha 

Forest area

Misc. Tree and Grooves

Permanent pasture

Culturable waste

Land put to non agri. Use

Barren & Un-culturable land

Current fallow

Other fallow

Net area sown
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Cotton is the major raw product of this sector. In Odisha, Cotton cultivation is an up-coming 

activity. Many of the western belt farmers mainly from Rayagada, Balangir, Kalahandi, 

Nabarangpur, and Nuapara districts are cultivating this cash crop because of suitable soil and 

climate conditions. Sea Island cotton is becoming familiar in the Ballipal region of Balasore 

district. 

An average of 3.5 lakh bales of Cotton is cultivating in the state, of which approximately 2 lakh 

bales are ginned and pressed in the state. The traders and spinners of other states procure the 

remaining cotton. The area of cotton cultivation has been increasing tremendously. But the 

problem of selling the cotton in right price to the right person/agent/ organization is the difficult 

task to the common farmers. The production process starts with the farmer. Once the cotton is 

yielded, small farmers are not able to sell it in right price as always there is challenge for them to 

bring the small amount of cotton to the market from such a remote area by any means of 

transportation. This also will be costlier than their final selling price of their product. Even 

though the government agency is working in that area for the purchase of cotton but it is not 

helpful to them. They are compelling to sell to the private agent in low price to avoid the price 

fluctuation and for getting early price realization of their product for the domestic expenditure in 

the day to day life. It leads to major losses but our point is that the farmers should sell to the 

Government for their beneficial reasons. 

We have studied how the traditional and major crops are diversified with commercial crop 

pattern in the three main districts, which we have seen commercial with contract type of farming 

is going on. Major commercial crop here is Cotton which changed the lives of the farmers in 

these districts due to its ultimate value in the Indian market. 

Cotton is majorly growing in these agro climatic zones North-Eastern Ghats (Ganjam (Part), 

Gajapati, Rayagada, Kandhamal, Boudh), Eastern Ghats Highland (Nabarangpur (Part), Koraput 

(Part)), Western Undulating Lands (Kalahandi, Nuapada), Western Central Table Lands 

(Bargarh, Subarnapur, Balangir). 

2.4 Suitability of Cotton in Odisha 

Cotton, being known as “White Gold”, is an important fibre crop of the agro-supply chain 

system. World cotton production currently stands at approximately 23 million tons, grown in 90 

countries, by an estimated 30 million farmers. 

Climatic requirements: 

Cotton is primarily grown in dry tropical and subtropical climates at temperatures between 11
0
C 

and 25
0
C. It is a warm climate crop threatened by heat or freezing temperatures (below 5

0
C or 

above 25
0
C), although its resistance varies from specie to specie. Excessive exposure to dryness 

or moisture at certain stages of the plant development (lasting five to seven months) may be 

detrimental. 
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The climatic factors also a play a major role while observing in Geospatial tools. The cloud 

should be clear for the perfect imagery. We have used the MODIS data, as the product will be 

obtained with cloud free in the monsoon season. 

In Odisha cotton is having good familiar conditions with undulating topography and subtropical 

climate. 

2.5 The Timelines of Non-Bt cotton and Bt- cotton in Odisha: (Bacillus 

thuringenesis) 

2.5.1 Period of Non-Bt: 

The farmers used to cultivate non-Bt varieties i.e. Hybrids or Desi varieties since 1990’s. It 

continues until Bt enters, the major reasons it has been replaced due to heavy pest damage to the 

crops. The varieties used in Odisha are MCU- 5, Sabitha, Bunny, Sri Tulsi and Dharani. The 

yield rate of the cotton varies from region to region, crop to crop and also is based on the type of 

seed used. Farmers at few fertile regions of Rayagada had said they used to get more than 20 

quintals seed cotton per acre. MCU- 5 is cultivated more in Rayagada and Nabarangpur districts, 

whereas the other varieties are cultivated in all other cotton cultivated districts. Among all the 

varieties, share of Sabitha variety in cotton farming is higher in the ending periods of Non-Bt 

cotton compared with MCU-5, as it is a high yielding variety, during the same period is lower. 

But MCU-5 is having good staple length compared with Sabitha and Bunny variety. 

The diversification of major crops like rice and millets to cotton as a commercial crop, had taken 

up by the farmers from Andhra Pradesh. Mainly the farmers concentrated in the concerned study 

areas especially Rayagada district. The input for cultivating cotton used to bring from their 

native places and taking here the lands for lease. They have taught the cultivation of cotton to the 

Odisha farmers, by that time the results of the yield and money of the cotton leads to spreading 

into other areas. Nearly thousands of families have been migrated from Andhra Pradesh and 

started cultivation here. In this way, the birth of cotton in Odisha has been took place. Major 

factors for cultivating here are suitable climate and topography, availability of labor is more, less 

land rent. This causes by spreading to other districts in the past 25 years. 

As the non-Bt varieties are prone to more pest damage, the field and environment in these 

conditions are fresh and the farmers made more money. But after 10 years the pest i.e. the 

bollworms had started damaging in these areas which causes huge losses for some farmers. Most 

of them returned to their homes in the periods of 1999-2002 due to lesser yields. 
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M.VENKATESWARULU 

The farmer hailed from Guntur, Andhra Pradesh to Odisha in 1995 for the cultivation of cotton. 

He settled at Bikrampur block, Gunupur, Rayagada district. Presently he is cultivating cotton in 

20 acres and red gram in 10 acres. 

He migrated to this place because of Black cottony soils, humid climate, less labor cost, less land 

rent, no bollworm attack as it’s a new place for the cultivation, High land topography which is 

more suitable for cotton growth and high availability of labor. 

Before 2002 it was Non- Bt, which the farmers used to cultivate and had shown better yields but 

after that the bollworm infestation started, farmers entered drastic losses in the period of the 

1999-2002. 

Now he is getting more profits by introduction of Bt cotton in India after 2002 which fills colors 

in their life. It increases their yield despite of high seed cost. But after certain period the release 

of new strain in Bt that is Bollgard 2 is susceptible to the tobacco caterpillars that leads in 

reducing yield. Now the farmer is in full sorrow because the whitefly attack has been increased 

dramatically which leads to the crop damage by Leaf curl virus. For that they are increasing 

pesticide sprays every year, it results in decreasing yield as it become more resistant with the 

certain group of insecticides. Farmers are asking for the control against this and they are 

rethinking about non-Bt seeds as they are happy when some good insecticides which kill 

bollworm instantly and in return providing better yields. But this new technology leads to 

increase in the whitefly attack. 

So that’s why farmer has been started red gram cultivation which is having good market by 

reducing cotton cultivation in the year 2016. 

Presently this year he sprayed the pesticides number of times and got good yield for cotton as 

this year had good rains. He sells his cotton to Cotton Corporation of India (CCI) every year. If 

he needs money urgently, he will sell some to the local private agents. 

 

2.5.2 Period of Bt: 

 

The golden phase started for the farmers after the year 2002 when Governement of India has 

approved Bt, a genetically modified crop for the cultivation. It has been released by Monsanto as 

BOLLGARD. This type of cotton has been the first biotech crop technology approved for 

commercialization in India in 2002. More than 6 million farmers adopted the technology on their 

farms. 
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In 2003 Monsanto introduced a second-generation trait product in cotton with Bollgard® II 

insect-protected cotton in 2003. The product provides farmers with the same benefits as the 

original Bollgard product, as well as expanded protection against other cotton pests. In 2006 

Monsanto becomes the first agriculture company to introduce a stacked second-generation 

product, launching Bollgard II with Roundup Ready Flex cotton. The product provides farmers 

with the same benefits as Bollgard II, as well as the flexits Roundup Ready Flex technology. 

Due to the success of Bollgard in India, in 2006 Bollgard® II – a double-gene technology-was 

approved by the Genetic Engineering Approval Committee, the Indian regulatory body for 

biotech crops. Mahyco-Monsanto Biotech (MMB) - a 50:50 joint venture between Mahyco and 

Monsanto Holdings Pvt. Ltd. sub-licensed the Bollgard II and Bollgard technologies to more 

than 30 Indian seed companies.  Each Indian seed company has introduced the Bollgard 

technology into their own germplasm. Indian farmers now have a choice of over 300 Bt cotton 

hybrid seeds.  Bollgard is used by more than 6 million Indian farmers. 

It has been a great choice for the farmers in that period after 2002 as they are happier for better 

results. It gave them double yield and money. But after a good of period time the new technology 

had also faced its new flaws. 

The Odisha government has become more concerned as the crops are diversified more by 

introducing Bt cotton in many areas. After it introduction number of districts is grown in a rapid 

time. Some farmers are benefitting and others not, the government had initiated a ban but the 

benefiting farmers did not care for the rules. Despite being discouraged by the Odisha 

government as a matter of policy, is being grown in many areas of Rayagada, Balangir and 

Kalahandi districts. Environmentalists have been protesting this genetically modified variety of 

cotton, as 93 goats died at a village in Balangir district allegedly after feeding on the leaves of 

cotton plants. However, government officials, who claim not to be encouraging the cultivation, 

remain blissfully oblivious to the fact that hundreds of farmers in Balangir and its adjoining 

districts grow Bt cotton with seeds procured from agents based in Andhra Pradesh. Sources said 

that attitude of the officials suited the Bt cotton promoters in Andhra Pradesh. Agents from 

across the border flood the rural areas of Balangir, Kalahandi and Rayagada with Bt cotton seeds 

providing even monetary support to the growers in certain cases. 

We have seen that cotton was being grown in an area of around 20,000 hectares in Balangir 

district, 18,290 hectares in Kalahandi and 12,410 in Rayagada. Koraput, Nuapada, Sonepur, 

Ganjam, Gajapati, Boudh, Phulbani, Bargarh were among the other cotton-growing districts of 

the state. However, officials have no idea about the scale and size of Bt cotton cultivation 

because, having taken a policy decision not to encourage it, they have never made an attempt to 

assess how it has invaded districts close to the Andhra Pradesh border. Some of the district 

agriculture officials confessed to have found evidence of Bt cotton cultivation during raids but 

said they could do little to stop farmers from purchasing the seeds from agents from other states. 

The farmers of Rayagada district, who have been growing Bt varieties, argue that the seeds are 

http://www.monsanto.com/products/Pages/genuity-bollgardII-cotton.aspx
http://www.monsanto.com/products/Pages/genuity-bollgardII-cotton.aspx
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easy to get and the crop is generally free from pests and insects. In contrast, the non-Bt crop 

involves a lot of expenditure on pesticides.  Environmentalists, however, describe this as a 

blinkered view of the situation. “They are saying what they have been asked to say by the agents 

from Andhra Pradesh. The truth is that Bt crop is dangerous to health because it causes severe 

itching among human beings and can be fatal in the case of cattle, adding that as long as the 

government does not intervene to stop its cultivation, the crop would continue to pose a threat to 

humans and animals. 

But the companies have guaranteed that there will be no side effects for the human and animals. 

They have said it is due to over application of pesticides can be fatal for the grazing animals. It 

has been proved that it did not release any toxic proteins in the soil, doesn’t cause to effect to 

microbial growth. 

 

BT cotton advantages: 

 Increases yield of cotton due to effective control of three types of bollworms, viz. 

American, Spotted and Pink bollworms. 

 Insects belonged to Lepidoptera (Bollworms) are sensitive to crystalline endotoxin 

protein produced by Bt gene which in turn protects cotton from bollworms. 

 Reduction in insecticide use in the cultivation of Bt cotton in which bollworms are major 

pests. 

 Potential reduction in the cost of cultivation (depending on seed cost versus insecticide 

costs). 

 Reduction in environmental pollution using insecticides. 

 Bt cotton exhibit genetic resistance or inbuilt resistance which is a permanent type of 

resistance and not affected by environmental factors. Thus, protects crop from 

bollworms. 

 Bt cotton is ecofriendly and does not have adverse effect on parasites, predators, 

beneficial insecticides and organisms present in soil. 

 It promotes multiplication of parasites and predators which help in controlling the 

bollworms by feeding on larvae and eggs of bollworm. 

 No health hazards due to rare use of insecticides (particularly who is engaged in spraying 

of insecticides). 
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BT cotton disadvantages: 

 High cost of Bt cotton seeds as compared to non Bt cotton seeds. 

 Less vigor if hybrid seeds are used for next year 

 Heavy usage of fertilizers. 

 Effectiveness up to 120 days, after that the toxin producing efficiency of the Bt gene 

drastically reduces. 

 Ineffective against sucking pests like jassids, aphids, whitefly etc. 

2.6 Major Cotton growing districts in Odisha: 

 

Figure 3 : Major Cotton growing districts in Odisha          

   Cotton is a major commercial crop in KBK districts in the kharif season. KBK (Kalahandi 

Balangir Koraput Region) in Odisha has been regarded as the most backward region by the 

planning commission. It includes eight districts mainly Kalahandi, Nabarangpur, Nuapada, 

Koraput, Rayagada, Malkangiri, Balangir and Sonepur. Recently three more districts have been 

included Ganjam, Nayagarh and Jajpur. 
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In the above figure the dark green colored are the major growing districts in area i.e our study 

area Balangir, Kalahandi, Rayagada and the light green colored are the less growing districts 

i.e. Koraput, Ganjam, Gajapati, Kandhamal, Baudh, Sonepur, Bargarh, Nuapada. 

The major crops grown in the study area are Rice, Maize, Finger millet, Green gram Red gram, 

Black gram and Horse gram etc. Rice cultivation dominates the cropping pattern to such an 

extent that achievements made in terms of diversification sometimes become overshadowed due 

to the small weightage of crops diversified into. Diversification towards commercial crops has 

taken place in the form of cotton, groundnut and sugarcane. From our study cotton emerges as a 

crop with high value per unit but its production is limited to mainly the KBK region and the 

districts with major cotton cultivating area are Balangir, Kalahandi and Rayagada. 

One of the most positive changes seen is the diversification of new area brought under 

cultivation towards cotton. Some of the farmers’ area under cultivation has gone up from a mere 

3 hectares to about 40 hectares. This change is most prominent in Balangir, Kalahandi and 

Rayagada. 

District Wise Major Key Indicators of Odisha during 2013-14 

                                                                                                         Area in '000hect. 

 

Districts 

Rainfall (in 

mm) 

Geographical 

area 

Cultivated 

area 

Net 

area 

sown 

Gross 

cropped 

area 

Kharif 

cropped 

area 

Rabi 

cropped 

area Normal 2013 

Balangir 1289.8 1422.9 657.00 346.00 292.00 353.88 471.78 117.90 

Kalahandi 1330.5 1855.6 792.00 378.00 335.00 381.26 598.31 217.05 

Rayagada 1285.9 1485.8 707.00 193.00 160.00 194.99 249.02 54.03 

 

Table 2: District Wise Major Key Indicators of Odisha during 2013-14 

Source: Odisha Agriculture Statistics 2013-14. 

2.6.1 Balangir: 

Geographical Situation: 

Balangir district is bounded by Sonepur and Boudh in the east, Nuapada in the west, Kalahandi 

in the south and Bargarh is in the north. It lies between 20
0
11

1
40

11
 – 21

0
5

1
08

11
 North Latitude 

and 82
0
41

1
15

11
 – 83

0
40

1
22

11
 East Latitude. 

Balangir is located under Western Central Table Land Agro climatic Zone characterized by hot 

and sub humid climate. Basing on the physiographic and irrigation availability Balangir District 

has been divided in to four Agro– ecological situations (AES) and characterized by a hot dry 

summer and highly erratic rainfall distribution of south–west monsoon rains i.e. 
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1. Plain land irrigated 

2. Undulating plain drought prone 

3. Undulating sub- mountainous tract rainfed 

Basic Information: 

Geographical area- 657000ha 

Cultivated area- 345475ha 

 High- 189325 

 Medium- 70155 

 Low- 85995 

 

Soil type: the district has Red and Yellow, Red and Black, Black, Laterite and Brown forest soil. 

Normal and Actual rainfall: 

Normal and Actual rainfall is 1289.8 mm. The district receives rainfall from the South-west 

monsoon during June to August. The coldest month of the district is December whereas the 

hottest month of the district is May. 

Temperature: The mean maximum and minimum temperature of Balangir district is 34.9
0
C and 

21.0
0
C with mean morning humidity 67% and evening humidity 57 %. Sometimes in summer 

season the maximum temperature rises to above 50
0
C. 

Condition of cotton in the district 

The main crops grown in Balangir are Rice, Black gram, Chickpea, Horse gram, Green gram, 

Groundnut and Cotton. Now a days Wheat and sugarcane are also improving. The area under 

rice has declined by about 8 percent in the case of profit earning farmers and 17 percent in the 

case of non-profit earners. There has been a substantial change in the area under cultivation. 

Also, area under rice has declined giving scope for crops like vegetables (other vegetables have 

increased in area from 2690 hectares to 17000 hectares), green gram, sesame and cotton. This 

decrease has resulted due to diversification from paddy towards cotton. There has been a nearly 

17-fold increase in the area under cotton. Increase in area in conjunction with increase in yield 

rate has led to a nearly 2567% increase in output. The yield rate post adoption in the case of 

cotton is higher in the case of profitable farmers as compared to non-beneficiaries. In Balangir 

90.5% of the households sell cotton at their farm gates and only 9.5% sell cotton at markets. 

Kantabanjhi, Jogimunda, Patnagarh, Belpara and Khaprakhol are the major cotton growing areas. 
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2.6.2 Kalahandi: 

Geographic location: 

Kalahandi district occupies the South-Western portion of Odisha and is situated between 

19
0
08

1
N and 20

0 
25

1
N Latitude and 82

0
 32

1
 E and 83

0
47

1
 E Longitude. 

It is bounded in the North by Raipur (Chhattisgarh), Balangir and Nuapada district. In the west 

by Raipur and Nabarangpur districts in the south Rayagada district and the east by Rayagada and 

Kandhamal districts. The total geographical area of the district spreads over 7920 sq.kms, 

comprising of 2 Sub-division which includes 13 blocks & 2238 villages with a breakup of rural 

& urban areas covering 7678 and 815 sq.kms, respectively. Area wise, the district ranks 7th in 

Odisha. 

 

Basic Information: 

Geographical Area: 792000 hectares. 

 

  

                        Figure 4: Geographical Area – Kalahandi 
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Soil type: 

The district has two distinct physiographic regions the plain lands and the hilly tracts. The Soil 

condition of the district can be broadly classified as under. 

 

Table 3: Soil type – Kalahandi 

Rainfall & Climate: 

The average annual rainfall of the district is 1330.5 mm. The monsoon starts in late June & 

generally lasts up to September. The rainfall is much erratic in the plain area punctuated by long 

dry spells. The climate of Kalahandi is like that of central Indian type where summer season is 

prolonged & severe with a brief spell of winter, which is main cause of drought, bring a normal 

feature of the district. May is the hottest month of the year where the maximum temperature 

reaches about 45
0
 Celsius (113 Fahrenheit). December is the coolest month where the mean of 

daily minimum temperature is recorded at 11
0
celsius (52 Fahrenheit). 

Condition of cotton in the district: 

The major crops growing in the district are Rice, Wheat, Cotton, Pulses and Vegetables and the 

cropping intensity has reached 167%. In Kalahandi, there has been a substantial increase in the 

area under cultivation and a slight decrease in area under rice. The increase in cultivated area has 

given scope for diversifying primarily into vegetables and cotton besides small increments in 

other crops. 

Kalahandi is marked by more than a 1081% increase in area under cotton in the case of 

profitable farmers and 266% in the case of non-profitable farmers. In actual terms the increase of 

about 24 hectares in the case of beneficiaries has been due to a 12-hectare decline in the area 

under paddy along with additional area cultivated being diverted towards cotton. But the sprayers 

use is more for cotton cultivation but in this district surprisingly lowest i.e. 37% compared with 

Sonepur district i.e. 73%, despite being a major diversified crop. But the production and area is 

higher in Kalahandi district. In the sale of cotton in Kalahandi the situation is completely in 

Sl.No. Type of soil Percent 

1. Red soil (Red laterite) 31.63% 

2. Black clay (Heavy) 13.90% 

3. Clay and Sandy loam 54.47% 
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contrast with Balangir. In Kalahandi, almost entire production (98%) of the cotton is sold at 

nearby mandis and only 2% is sold at farm gates. 

Since two decades, cotton cultivation in the non-irrigated black cotton soil has come up 

immensely from 5000 ha in 1996 to 46152 ha. in 2015. The major Cotton growing blocks in 

Kalahandi district are Bhawanipatna, Kesinga, Golamunda, Narla, M.Rampur and Lanjigarh. 

Besides the support of green revolution in the Indravati Aycut area of Indravati project in 

Jaipatna, Kalampur, Junagarh, Dharamgarh blocks of the district the impact have also been felt 

in non-irrigated blocks of the district. This saw progress in the field of Paddy, Cotton, Maize, 

pulses and oil seeds and the district is in the green revolution phase. Now Kalahandi is the 2nd 

highest Rice and Maize growing and the highest Cotton growing districts of the state. Special 

centrally sponsored scheme of national food security mission to increase production and 

productivity of Rice, Pulses & Cotton in a sustainable manner,) 

Source: SAMIKSHYA (Directorate of Economics & Statistics Journal of Socio-Economic Issues, 

Vol.10; June-2016) 

2.6.3 Rayagada District: 

Geographic location: 

Rayagada district is located between 19
0
0

1
and 19

0
58

1
 north latitude and 82

0
5

1
 and 84

0
2

1
 east 

longitude in the southern part of Orissa. It is bounded by Gajapati district in the east, Koraput 

and Kalahandi districts in the west, Kalahandi and Phulbani districts in the north and Koraput 

and Srikakulam (Andhra Pradesh) districts in the south. As per 2001 census the district having 

7073 sq. kms of geographical area occupies the 8th rank in the state. The district of Rayagada is 

constituted by five towns including two census towns and 2,667 villages spread over 11 C.D 

blocks. 

Basic information: 

Geographical area- 758745ha 

Cultivated area- 193504ha 

 High- 128962ha 

 Medium- 42705ha 

 Low- 21837ha 

Climate: Rayagada district comes under North Eastern Ghats Zone characterized by hot, moist 

and sub-humid climate and classified as tropical. The summers here have a good deal of rainfall, 

while the winters have very little. The average annual temperature in Rayagada is 26.5 °C. The 

average annual rainfall is 1312 mm. 

Soils: It consists of Brown forest, lateritic, Red alluvial, Black and mixed Red Soil groups. 
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Condition of cotton in the district: 

The major crops growing in the district are Rice, Wheat, Finger millets, Green gram, Black 

gram, Groundnut, Sweet potato, Maize and Cotton. Rayagada district is the main place of birth 

for cotton in Odisha. As the farmers from Andhra Pradesh had moved here at this district in the 

places named Gunupur, Muniguda and Padampur. They started cultivation of cotton since two 

decades by taking lands on lease. Most of the farmers are contract based and largely growing 

cotton in these areas. The major growing blocks are Gunupur, Muniguda and Rayagada. 

In Odisha state, Rayagada district cotton stands for best in quality and production. Most of the 

produced cotton exported to Gujarat and Andhra Pradesh through private traders. Some of the 

farmers are using CCI for selling the cotton. Here the soil and climate are mostly favorable for 

the cotton growers. The area is increasing rapidly from 16970 ha. in 2006-07 to 26700 ha. in 

2013-14. 

 

2.7 Area, Yield and Production of Cotton (Kharif) in 2013-14 for the study area 

A=Area in ‘000ha.      Y=Yield in Kg. /ha.            P=Production in ‘000bales 

DISTRICT AREA YIELD PRODUCTION 

Balangir 39.76 435 101.74 

Kalahandi 43.06 333 84.35 

Rayagada 26.71 499 78.40 

Source: Odisha Agriculture Statistics 2013-14. 

  Table 4: Area, Yield and Production of Cotton (Kharif) in 2013-14 for the study area 

 

The Production of Cotton has declined from 336 thousand bales in 2012-13 to 299 thousand 

bales in 2013-14. 

In the below figure, we can clearly observe that Balangir, Kalahandi and Rayagada districts are 

with more area and production of cotton. In other districts, cultivation of cotton has becoming 

more familiar in recent years. 
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District Wise Area, Yield and Production 

 

Source: Odisha Agriculture Statistics 2014-15 

 Figure 5: District Wise Area, Yield and Production 

2.8 Statistics of 2013-14 for the Classification of Study Area 

 

 Crop wise irrigated area during Rabi 2013-14 

                                                                                              Area in '000 ha. 

Districts Rice Wheat Maize Total pulses Total oilseeds 

Balangir 3.86 0.52 0.66 3.55 7.59 

Kalahandi 39.51 2.47 1.18 5.29 10.85 

Rayagada 4.04 0.13 2.02 2.56 3.74 

 

Table 5:Crop wise irrigated area during Rabi 2013-14 
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 District Wise Area Covered Under Mixed Cropping During 2013 

                                                                                                           (Area in ha.) 

Name of the district Red gram + Cotton + Jowar Cowpea + Cotton 

Balangir - 2362 

Kalahandi 71 - 

Kandhamal 77 - 

Rayagada 1100 - 

Gajapati 3180 - 

Ganjam 360 - 

Bargarh - 800 

Source: Odisha Agriculture Statistics 2013-14. 

Table 6: District Wise Area Covered Under Mixed Cropping During 2013 

2.9 Cotton: Marketing and Value Addition 

Though the contribution of Odisha towards India’s total cotton production is barely 0.5%, the 

cotton produced in the state is of exportable quality. In the study area, the districts are involved 

in various types of marketing. 

The marketing of cotton is undertaken mainly through three types of agencies 

1. Corporations and Cooperatives 

2. Private Traders 

3. Contract Farming 

In Odisha, the buying and selling of cotton is regulated by the Regulated Market Committees 

established as per Orissa Agriculture produce and Market Act 1956. Five market yards have been 

established under five RMCs equipped with godowns, auction, halls, farmers rest sheds, farmer 

information centers and grading laboratories. The procurement centers for cotton include: 

 Kesinga and Utkela under Kesinga RMC, Karalada under Bhawanipatna RMC which will 

come under Kalahandi district. 

 Gunupur, Muniguda and Rayagada under Rayagada RMC. 

 In Balangir District cotton procurement centers include Kantabanjhi and Jogimunda 

under Kantabanjhi RMC. 

The firms buying this cotton include Eco Farm (India) Pvt., Kesinga, Bioorganic farm, natural 

organic, Amita group, Kamadhenu Ginning mill, V.V. Cottons, Boirays, Ambika Agro 

industries, Jaydurga Ginning mill, Natural organic Pratima Agro Industry, and Cotton 

Corporation of India. From these 92% of the cotton is procured by Private traders and 5% by the 

CCI. 
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The advantages of the RMCs are proper weighing of cotton, help in grading, payment of proper 

price due to auction in the form of cash or cheque, storage space and knowledge about rates at 

different markets. 

The area under cotton was increased dramatically in the three districts from 2006-07 to 2013-14. 

Major change is seen in Balangir and Kalahandi districts because of availability of more black 

soils. 

                                                                                                            (Area in ha.) 

Districts 2006-07 2013-14 

Balangir 19600 39800 

Kalahandi 16040 43100 

Rayagada 16970 26700 

                                          

                                          Table 7: Area under cotton 

2.9.1 Contract farming scenario in study area 

            The farmers of these areas have also entered the arena of contract farming over the years. 

The inclination of the farmers towards instant cash and assured market has attracted them for 

contract farming. This has resulted in more and more farmers entering the process and utilizing 

their land for contract farming instead of traditional farming practices. The widespread practice 

of contract farming for jatropha, cotton, maize, rubber, lemongrass and groundnut is indicating 

that Odisha is also in favor of contract farming. 

 

Advantages and disadvantages of Contract Farming: 

The vertical coordination involved in contract farming has both advantages and disadvantages to 

both the contractual parties, i.e. the farmer and the company. The advantages of such a system is 

often more pronounced for a state like Odisha where agriculture is predominant and small 

farmers are large in number because contract companies provide with necessary inputs and 

extension services. It is however not free from problems. The benefits that farmers and the 

companies can accrue along with the constraints they face in entering contract. 

Advantages 

 Inputs and production service provided to the farmers 

 New technologies and new skills made available to the farmers 

 Linking with new market to the small farmers 

Disadvantages 

 Manipulation of quotas by the contractors. 

 Sponsoring companies may be unreliable or exploit a monopoly position. 
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 The staff of sponsoring organization may be corrupt, particularly in the allocation of 

quotas. 

 Farmers may become indebted because of production problems and excessive advances. 

 Gradation is made by the company. 

For a farmer, the advantage largely lies with the fact that he gets access to inputs and extension 

services which otherwise would not been easily available to him. One of the most attractive 

benefits for the farmer is linkage which he gets with credit, since farmers use the contract 

agreement as collateral to arrange the credit with a commercial bank in order to fund inputs. 

Farmers do not have to search for and negotiate with local and international buyers since project 

sponsors usually organize transport for their crops normally from their farm gate. But at the same 

time, a farmer while entering into contract of growing new crops should be ready to bear the 

production risk of the quality and market prices in some cases, risk of handling advanced 

technology which he usually is not acquainted with, manipulation of quotas by the companies in 

case the market is not favorable, and risk of indebtedness with the production problems. 

2.10 Odisha state cotton purchases by Cotton Corporation of India from 2009-10 to 

2013-14 

It clearly shows that the whole cotton sold is major for private traders and less for CCI 

i.e. M.S.P. The contract farming rate is higher and it leads to more exporting and goes to 

the hands of private people. 

 

Source: Cotton Corporation of India Ltd., Navi Mumbai. 

 Figure 6: Quantity in thousand bales of 170 kgs each 
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 District Wise Procurement of Seed Cotton by different farms during 2013-14 

Quantity in Qtl. 

District CCI Private Total 

Balangir - 324852 324852 

Kalahandi - 445509.62 445509.62 

Rayagada 22703.54 407217.96 429921.5 

Source: Odisha Agriculture Statistics 2013-14.  

Table 8: District Wise Procurement of Seed Cotton by different farms during 2013-14 

    It clearly shows above the major producers of study area i.e. Balangir and Kalahandi are 

selling to the Private rather than CCI. Only Rayagada district farmers are benefiting by selling 

their produce to the CCI. 

The ultimate decision is lies within the farmers as they are losing huge amount of money by 

selling to private traders. 

 

 

PURNA CHANDRA RAO 

 

Purna Chandra Rao, an old man of 75 years and a farmer by profession, lives with his wife in 

Bikrampur village of Gunpur block. He originally hails from Varshing village of Chaluamba 

Panchayat of Guntur district (Andhra Pradesh). He migrated to Odisha in 1995. He was 

cultivating cotton and chilly in his native place. He faced loss there and came to Odisha in 

search of land that suited cotton cultivation. He found the land in Gunupur block and shifted 

with his family. Now after 15 years he is known as one of the successful farmers and a big 

producer of cotton in Gunupur. He is the first man who started cotton cultivation in Gunpur. He 

did not leave his field in Andhra Pradesh but leased it out to local people. Now his son is 

cultivating the field there. 

When he came to Odisha, lease rate of land was comparatively cheap. He took 30 acres of land 

on lease @ Rs.500 per acre and started cotton cultivation from which he earned huge profit. 

Then slowly he expanded his cotton cultivation. In the year 2006, he took 70 acres of land on 

lease for three years, 35 acres in Reguda and other 35 acres in Vikrampur. But he incurred a 

drastic loss in Reguda as the land was not suitable for the cultivation. He directly sells the 

produce to Cotton Corporation of India (CCI), and never depends on the contractor or 

middleman. The CCI, Odisha has fixed the rate of cotton at Rs.3000.00/- per quintal. He has not 

signed any contractual agreement with them as he has hope on them as an old seller. 

Now he is old and unable to carry out such a huge job. He has reduced the operation to 8 acres. 

Apart from this he is now busy in maintaining a farm house where he has planted lemon in 3 

acres, teak in 4 acres and other fruit plants like papaya, coconut, guava, mango etc. along with 

many kinds of flowers too. The land in which farm house is made belongs to another person, who 

is living in Hyderabad. He is maintaining the land properly from which he gets much 

satisfaction. He said that whenever he will face drastic loss again in Odisha, the possibility of 

which is very low, he will go back to his state. 
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2.11 Missions on improving cotton in Odisha: 

 National Food Security Mission (NFSM): Commercial crops (Cotton, Jute and 

Sugarcane) 

Commercial crop is being implemented under which it has been envisaged to promote fiber crops 

like Jute & Cotton. The present aim is to raise the area under cotton to above 134000 ha. by 

substituting the crop in high land where non-remunerative non-paddy & paddy crops are grown. 

Steps are being taken to make available quality hybrid & high yielding seeds to cotton growers in 

the state. Besides, technical assistance for raising the crop is being rendered through the 

extension personnel of the department. 

 District wise seed distribution during Kharif 2013 

For the development of cotton, Government of Odisha supplied seeds for the Kharif 

season. 

 

Source: Odisha Agriculture Statistics 2013-14. 

Figure 7: Kharif 2013 Production District wise 

 Intensive Cotton Development Programme (ICDP) 

 

Mini-Mission-II of Technology Mission on Cotton: 

The Intensive Cotton Development Programme (ICDP) is now implemented as a Mini 

Mission - II under the Technology Mission on cotton and one of the major commercial crops. 

Cotton is predominately grown in the KBK districts in the Kharif season and one of the major 

commercial crops. Cotton cultivation has been increasing in Balangir, Kalahandi and Rayagada 

districts. During 2013-14, emphasis was given on area expansion, use of quality/ hybrid seeds, 

farmers training and intensification of IPM practices etc. 
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During 2013-14, 100 Farmers Field Schools (FFS) and 412 Front Line Demonstrations 

(FLDs) were taken up to train & demonstrate the farmers on use of latest production technology. 

Besides, to popularize the use of pheromone traps on cotton crop for control of pests, ₹0.90 lakh 

has been utilized to cover 299 hectares during 2013-14. To educate the cotton farmer’s 86 

awareness campaign programmes for fiber quality management and 150 farmers’ trainings were 

organized with an expenditure of ₹16.10 lakh. During 2013-14, 28 sprinkler sets were supplied 

to the famers with a subsidy amount of ₹4.20 lakh. 

One of the most positive changes seen is the diversification of new area brought under 

cultivation towards cotton. 

 In Balangir, the average price of cotton is marginally higher at the mandis (₹3,700/q) as 

compared to price at farm gate (₹ 3,600/q). 

 In Kalahandi, the average price of cotton is marginally higher at mandis (₹ 3,650/q) as 

compared to price for the private traders (₹3,500/q) 

 In Rayagada, the average price of cotton is marginally higher at ginning mills and CCI 

(₹4,000/q) as compared to price at farm gate (₹3,800/q). 

 

 MSP of Cotton from 2011-12 to 2013-14 

₹/Qtls. 

VARIETY 2011-12 2012-13 2013-14 

Medium staple 2800 3600 3700 

Long staple 3300 3900 4000 

Source: Odisha Agriculture Statistics 2013-14 

Table 9: MSP of Cotton from 2011-12 to 2013-14 

2.12 Odisha Data from 2006-07 to 2015-16 

 

 Due to diversification into cotton and other commercial crops from rice and other millets, 

the farmers are getting more benefited. The year wise change or shifting into other crops 

leads to more variation in the pattern. From the below figure, we can observe the changes 

of cotton in Odisha in Area, Yield and Production 
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Source: Cotton Advisory Board; P-Provisional; *As per CAB meeting dated 2-2-2016                  

*Inclusive of State-wise loose cotton production 

Figure 8: Odisha Data from 2006-07 to 2015-16 Odisha Data from 2006-07 to 2015-16 

 From the three timelines mentioned below in the figure we observed a gradual increase of 

area in the cotton growing districts of Odisha. The study area has shown majority of all 

the districts. 

 

Zero denotes either nil or negligible 

Figure 9: Increase of Area in the Cotton Growing Districts of Odisha. 

Source: Odisha Agriculture Statistics (2007-08 to 2013-14), Directorate of Agriculture and Food 

Production, Govt. of Odisha. 
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 We have also observed the statistics of Rice areas which shows unproductive yields and 

diversified to Cotton and other high value crops. 

 

District 

Percentage change 

(1997-98 to 2001-02) (2001-02 to 2005-06) 

Area Yield Prod Area Yield Prod 

Balangir -5.39 23.74 17.05 10.04 -12.57 -3.77 

Sonepur -0.15 3.52 3.38 2.52 13.75 16.63 

Kalahandi 13.57 -0.22 13.30 10.11 -21.37 -13.40 

Nuapada 5.17 33.69 40.56 -3.24 -22.82 -25.30 

Koraput 27.61 25.82 60.49 -2.26 9.69 7.23 

Malkangiri 15.32 48.70 71.44 -3.10 25.74 23.02 

Nabarangpur 11.07 12.59 25.05 1.63 -3.39 -1.80 

Rayagada 8.98 20.73 31.52 -22.65 -5.88 -27.17 

KBK 8.37 14.73 24.36 2.42 -5.26 -3.02 

           Table 10: Percentage Change in Area, Yield and Production of Rice in KBK Districts               
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CHAPTER 3 

                              MATERIALS AND METHODS 

3.1 Materials used 

3.1.1 Remote sensing data 

1. MODIS (250 m resolution) time series NDVI multi-spectral data (2010-11, 2013-14 and 

2016-17) 

3.1.2 Software used for the study: 

1. Land use/Land cover Mapping 

 ERDAS Imagine 10.4 

 Google Earth Pro 

2. Geospatial Analysis and data conversion 

 ArcGIS 10.2.2 

 MODIS Re-projection Tool (MR Tool) 

3. Analysis and Report writing 

 Adobe reader, Microsoft Excel, Word and PowerPoint 

3.2  Land use database 

Land use /Land cover for the crop years of Odisha state are prepared using MODIS Time-Series 

Mega files of Normalized Difference Vegetation Index (NDVI) are downloaded from the USGS 

Earth explorer website. 

The Normalized Difference Vegetation Index (NDVI) is a simple graphical indicator that can 

be used to analyze remote sensing measurements, typically but not necessarily from a space 

platform, and assess whether the target being observed contains live green vegetation or not. 

NDVI is calculated from the visible and near-infrared light reflected by vegetation. Healthy 

vegetation absorbs most of the visible light (Red) that hits it, and reflects a large portion of the 

near-infrared light. Unhealthy or sparse vegetation reflects more visible light (Red) and less near-

infrared light. NDVI = (NIR — RED) / (NIR + RED) where NIR is ‘Near infrared’. 

Calculations of NDVI for a given pixel always result in a number that ranges from minus one (-

1) to plus one (+1); however, no green leaves give a value close to zero. A zero means no 

vegetation and close to +1 (0.8 - 0.9) indicates the highest possible density of green leaves. 

We have taken the path and row of h25 v06 and h25 v07 for the study area purpose. 

The downloaded files of MODIS are in .hdf format and it will be converted into .tif files in the 

conversion tool named MODIS reprojection tool. 
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 3.3 Process of MR Tool 

1. Open the MR Tool file. 

2. Add .hdf files: Insert the data of downloaded modis .hdf files i.e. which is stored in 

ODISHA 2013-14 folder by clicking Open Input File. We have to select the single day 

images at a time. Two tiles are covered the entire Odisha area, so we selected 2 .hdf files 

of the same date. 

 

 

Once the .hdf files are loaded, the source information is displayed in the Input File 

Info, Available/Selected bands, Spatial Subset and Coordinates. 
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3. Band selection: By default, all available bands are selected and appear in the box to the    

right (Selected Bands). We need only NDVI band. To separate certain bands from 

processing, click on the unwanted bands and use the “<<” button to deselect them (below 

figure). This will move it to the box on the left (Available Bands). To move bands from 

the Available box to the Selected box, click on the desired band and use “>>” button. 

 

4. Output file: Specify the output file by naming it and created a destination folder for the 

files. Provided an output name like the input file name i.e. “MOD13Q1.A2013161” 

which should be saved in .tiff format we have followed the same consistency. 
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It is very important to include the file extension as part of the file name. The file extension 

indicates the file format of the output image. If we add “.hdf” it will give HDF-EOS, “.tif” will 

give GeoTIFF and “.hdr” will give raw binary. 

 

In Output File Type, we have selected GEOTIFF which is a standard image format in image 

processing software. 

5. Resampling: Selected the Resampling Type as “Nearest neighbour”. 

 

 

6. Reprojecting: It transforms the sinusoidal equal area projection of the input .hdf into the 

geographic coordinate system. 

 The Output Projection Type is selected from the list as Geographic 
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For the parameters we have to open Edit projection parameters and select WGS 84 as datum. 

 

 

7. Output Pixel Size: 0.002105 degrees. it should be defined as our outpt image will be in 

geographic coordinates, the pixel resolution is measured in degrees. MOD13Q1 is 250m 

resolution, this is equivalent to 0.002105 degrees at the equator. 

 

 

 

8. Executing the conversion: Clicked RUN button to stop the conversion process. 
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After processing, the status window appears as “Finished processing”. 

 

 

 

9. End product .tiff file which will be shown as below of two tiles. Like the below process, 

it should be done for all the tiles of julian dates for the given year. 
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10. Mega-file data cube composition 

      Many bands of data of a study area are combined from numerous dates into a single file 

referred to as mega-file. These mega data sets have no limitation for size or dimension of a 

mega-file. 

      A time series of MODIS 16-day composite reflectance images of 250 m resolution was 

obtained for 10June, 2013 to 25May, 2014 (MOD13Q1 data product).  The 16-day composite 

images in the MOD13Q1 data set are free of cost and pre-calibrated. The large- scene size and 

daily overpass rate of MODIS make it attractive for crop mapping of large areas, and NDVI 

derived from MODIS has high fidelity with biophysical parameters.  The composites are created 

using the maximum NDVI method on the daily MODIS data to minimize cloud effects (Holben, 

1986).  The 16-day composite images were downloaded for the year 2013 starting Julian day 

161.  There were one to two 16-day composites per month for a total of 23 16-day composites. 

Monthly MVCs for June 2013 to May 2014 were created using the 16-day images to minimize 

cloud effects during the monsoonal season. The monthly MVCs were stacked into a 12-band 

NDVI MVC mega-file image (MFI). ERDAS 

The above process was done in ERDAS ER Mapper and Imagine 2014. 

 ER Mapper involves in advanced image processing and compression capabilities. 

 ERDAS Imagine is a remote sensing application with raster graphics editor abilities 

designed by ERDAS for geospatial applications. Imagine is aimed mainly at geospatial 

raster data processing and allows users to prepare, display and enhance digital images 

https://en.wikipedia.org/wiki/Remote_sensing_application
https://en.wikipedia.org/wiki/Raster_graphics_editor
https://en.wikipedia.org/wiki/Geospatial
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for mapping use in geographic information system (GIS) and computer-aided 

design (CAD) software. It is a toolbox allowing the user to perform numerous 

operations on an image and generate an answer to specific geographical questions. By 

manipulating imagery data values and positions, it is possible to see features that would 

not normally be visible and to locate geo-positions of features that would otherwise be 

graphical. The level of brightness or reflectance of light from the surfaces in the image 

can be helpful with vegetation analysis, prospecting for minerals etc. Other usage 

examples include linear feature extraction, generation of processing work flows (spatial 

models in Imagine), import/export of data for a wide variety of formats, ortho 

rectification, mosaicking of imagery, stereo and automatic feature extraction of map 

data from imagery. 

 

3.4 Process of Erdas ER Mapper for creation of Maximum Value Composite files 

3.4.1. Preparation of NDVI time series composite 

 

1. Open Erdas ER mapper and click ‘New’ file and then click ‘Edit Algorithm’ icon. 

 

 

 

 

https://en.wikipedia.org/wiki/Geographic_information_system
https://en.wikipedia.org/wiki/Computer-aided_design
https://en.wikipedia.org/wiki/Computer-aided_design
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2. Added a  Raster Dataset named “MOD13Q1.A2013161.250m_16_days_NDVI.tif” in   

 

 

 

3. After this open “Formula Editor” and entered “if i1<=0 then null else i1/10000”. 

Click ‘Apply changes’ then the colour of the map changes from Red to Blue. 
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4. Open Transformation limits and assign input limits as 0 and 1 and go for 

transformation and click edit transform limits icon and then the window in the below 

opens, click on the Edit pull down menu and click delete this transform (this is done 

to retain the real values) 
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Important note: the two steps mentioned above are critical in the process of creating a megafile hence 

always double check at this point to make sure that steps have been accurately executed. 

5. Using the duplicate icon shown in below make one more duplicate of the same. 

Then rename the layer as NDVI_10JUN2013 to NDVI_26JUN2013. 
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Same procedure repeats and link corresponding layers…. Finally, 16 day NDVI images are 

shown in below. 

 

NOTE: 

 In the figure shown above, make sure that the right data is loaded into the appropriate 

layer. 

 Keep saving the algorithm file after completing every 3 or 4 Julian dates. 
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6. Then right click to Quick Zoom-> Zoom to all Datasets and save the file as .alg as shown 

below “India_MOD13Q1_16day-NDVI_2013-14_250m.alg” then click OK. 

 

 

 

 

 

7. Continue the above procedure for rest of the dates. Make sure that all the dates and 

bands are properly filled into the spaces provided. Check at least twice before saving 

the file in the ERS format. Save the algorithm file in .ers format 



48 

 

 

From the Data Type pull down menu, select the proper data type to save (in this case 

IEEE4ByteReal) and click OK. This ends the session for creating a Mega file (Time series data) 

for MODIS NDVI Data. 
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3.4.2 Preparation of Megafile for NDVI-Maximum Value Composite (MVC) 

 

1. Open the NDVI file i.e. “India_MOD13Q1_16day-NDVI_2013-14_250m.ers” NDVI 

megafile. 

 

 

2. Once the NDVI file is opened, click on the Edit Algorithm icon and change the RGB 

color combination to  Pseudo. Cut the Green and Blue layers, change the Red layer into 

Pseudo color. 
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3. Rename the pseudo layer as “NDVI_JUN2013”. 

 

 

 

 

4. Click on the Edit formula and type the formula “MAX(i1,i2)” depending on the number 

of images acquired in that particular month. 

 

 

 

5. Click on the Edit Transformation Limits icon and click on Edit pull down menu and click 

delete this transform and click Close. 
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6. Duplicate the first layer, i.e. NDVI_JUN2013 and rename the duplicated layer as 

NDVI_JUL2013, which is the Maximum Value Composite for the month of July. The 

formula same as Jun (MAX (i1, i2)), where i1 and i2 are the NDVI layers for the dates 

12
th

, 28
th

 of July 2013. The output layer. i.e. NDVI_JUL2013 represents the Maximum 

NDVI value for each pixel amongst the selected 2 NDVI layers for that particular month 

(i.e. JULY). 

 

 

 
7. Repeat the same procedure for the rest of the months, taking note on the number of 

acquisitions for the particular month that we are processing and keep changing the 

formula accordingly. 
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8. Then right click to Quick Zoom-> Zoom to all Datasets and save the file as .alg as shown 

below “India_MOD13Q1_NDVI-MVC_2013-14_250m.alg” then click OK. 

 

 

9. After computing the MVC for all the months, save the algorithm file as 

“India_MOD13Q1_NDVI-MVC_2013-14_250m.ers”. while saving, save as data type as 

IEEE4ByteReal and click OK. 
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10. This ends the session for creating the Megafile for Maximum Value Composite. 

Resultant NDVI-MVC of June 2013- May 2014 has shown below. 
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3.5 Process of Erdas imagine 

This process used for image conversion and clasification purposes. 

 

3.5.1 Creation of Image file 

1. After the completion of process in Erdas ER Mapper, the .ers file should be converted to 

.img file as a main part for classification. 

Open Import data-> Change the format into ER Mapper(Direct Read)-> Load the saved 

MVC .ers file i.e. “India_MOD13Q1_NDVI-MVC_2013-14_250m.ers” in Input and 

the output is should be with an extension of .img and click OK. 

 

 

 

 

2. After conversion into .img file open the saved file in the Erdas imagine. 
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3. After loading of the image file the required data of my case study has to be subset in the 

India image. 

Launch Command Window and enter Imagine. 
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4. Open Viewer and load the image file. 

 

 

 

5. Load the Odisha shape file on the image file. 
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6. Mark the AOI (Area of Interest) on the selected districts i.e. Balangir, Kalahandi and 

Rayagada districts from the Odisha state shape file. 

 

 

7. After marking AOI, click Data Preparation->Subset Image->Load the image file in Input-

>For the output file named as “odishadist_ndvimvc.img”->Select the AOI marked on 

the districts and click option AOI in Subset window-> Click Viewer-> Click OK. 
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8. It leads to dissection of required districts of study area and further it follows the next 

steps towards classification. 
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3.6 Mapping of Land use / Land cover 

 

After the generation of mega files, land use/ land cover for the years of study are 

mapped using ERDAS Imagine 2014 and Google earth. Land use classification is 

done with the help of ‘unsupervised classification’ tool in ERDAS. Using this tool, 40 

classes were divided and average NDVI values are calculated for the mega files. 

Based on the average NDVI curves and ideal curves, the land use is classified into 

Rice, Cotton, Waterbodies, Forests and Shrub lands and the similar classes are 

merged. 

Land Use mapping involves various protocols such as unsupervised classification 

(Kreuter n.d., Levien 1999) and spectral matching techniques. In unsupervised 

classification, image processing software classifies an image based on natural 

groupings of the spectral properties of the pixels, without the user specifying how to 

classify any portion of the image. Conceptually, unsupervised classification is like 

cluster analysis where observations (in this case, pixels) are assigned to the same 

class because they have similar values. The user must specify basic information such 

as which spectral bands to use and how many categories to use in the classification or 

the software may generate any number of classes based solely on natural groupings. 

Common clustering algorithms include K-means clustering and ISODATA clustering. 

Unsupervised classification yields an output image in which several classes are 

identified and each pixel is assigned to a class. These classes may or may not 

correspond well to land cover types of interest, and the user will need to assign 

meaningful labels to each class. Unsupervised classification often results in too many 

land cover classes, particularly for heterogeneous land cover types, and classes often 

need to be combined to create a meaningful map. 

Unsupervised classification using ISOCLASS cluster algorithm (ISODATA in 

Imagine 2010TM) followed by progressive generalization, was used on 12-band 

NDVI MFDC constituted for the crop years 2013-14. The classification was set at a 

maximum of 40 iterations and convergence threshold of 0.99. In all 40 classes were 

generated for each segment. Use of unsupervised techniques is recommended for 

large areas that cover a wide and unknown range of vegetation types. The 40 classes 

obtained on time series composite from the unsupervised classification were merged 

using rigorous class identification and labeling using protocols. 
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3.6.1 Ground truth collection:  

 

We have collected some ground truth points in the district of Rayagada for Cotton 

Crop Latitude Longitude 

Cotton  19° 5'12.43"N  83°47'30.73"E 

 

Cotton  19° 5'37.22"N  83°47'48.01"E 

Cotton  19° 5'43.30"N  83°47'57.59"E 

Cotton  19° 6'6.34"N  83°48'12.78"E 

Cotton  19° 7'59.20"N  83°45'41.20"E 

                               

                                                   Table 11: Ground truth points 

 

3.6.2 Process of Unsupervised classification 

 

1. Click Raster->Unsupervised classification 

 

                Input Raster File i.e. the saved odishadist_ndvimvc.img-> Name the output cluster 

layer as unsup_odishadist_ndvimvc.img-> Name the output signature set as  

unsup_odishadist_ndvimvc.sig->  Click  Isodata and give Classes from 40 to 40->  Change color 

scheme options from Red 4 Green 3 Blue 2 to Red 5 Green 4 Blue 3-> Put Maximum iterations 

to 40 and Convergence threshold to 0.990-> Click OK. 
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2. Product of this conversion gives the unsupervised image and signature file for the 

process of classification. 

 

 

3. Click Raster-> Supervised-> Signature Editor-> Load the saved signature file i.e. 

unsup_odishadist_ndvimvc.sig 
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4. Click view in the signature editor-> Columns-> Statistics-> Choose Mean-> Click 

Apply 
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5. After applying we can observe the mean values of 12 months i.e. June-2013 to 

May-2014. 

Select the all mean values-> Click Edit-> Copy-> Paste in Microsoft Excel sheet for 

further processing. 

 

 

 

 

6. Open Viewer and load the unsupervised image i.e. 

“unsup_odishadist_ndvimvc.img” 
Click Raster in Viewer pane -> Select Attributes. 
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7. After opening Attributes-> Select Column properties-> Columns->Color(Uncheck 

RGB)-> We can adjust Display width for our convinience and can arrange the 

categories by using ‘Up-Down-Top-Bottom’-> Click OK. 
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8. Make the Opacity as ‘0’ by using formula and click Apply. 

 

9. Added the maximum value composite layer (odishadist_ndvimvc.img) on the 

unsupervised layer. 

 

10. For this layer, we have to change the band combinations from Red 4 Green 3 Blue 2 

to Red 5 Green 4 Blue 3 and it changed accordingly to it-> Click OK 
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11. Open View and make sure that the unsupervised layer should on the top of ndvi 

mvc layer-> Click Apply. 

 

 

 

12. After adjusting layers related for the classification, they should be saved 

accordingly after every edit of the classes. 

The process includes the following steps. 

i. For recoding the desired area from one class to other we must select 

Raster-> Attributes-> Observe which class has been pointed on our 

desired area. 
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ii. After observing the required class, we must select Raster-> Recode-> 

Select the required class-> Enter the new value in the place of old value. 
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The following classes are identified during the process of classification. 

Cotton crop lands at Kalahandi district. 

 

 

Cotton fields at Rayagada district. 
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Rice fields at Balangir district. 

 

 

Forest area observation 
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iii. After checking of all the 40 classes, we have to combine all the repeated 

class names into one single class and give unique color to differentiate 

the classes. This process is called Recoding. For that we must select 

Image Interpreter-> GIS Analysis-> Recode. In the input file we have 

placed “unsup_odishadist_ndvimvc.img” and given output as 

“recoded_image.img”. During recoding enter the new value for each 

class. 

 

 

 

 

 

iv. The 40 classes are recoded into 12 classes, and the image should be 

reprojected to know the area of respective classes. For that we must 

select Data Preparation-> Reproject Images -> Input file: 

recoded_image.img-> Output file: reprojected_image.img-> In 
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Categories select UTM WGS 84 North-> In Projection select UTM Zone 

44 (Range 78E – 84E)-> Ignore Zero in Stats.-> Press OK. 

 

 
 

 

 

v. After the process of reprojection open the reprojeted image file in the 

viewer and select attributes. In the attributes table, add Area column 

beside the class name and we can observe the area in hectares. 
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3.7 Spectral Matching Techniques (SMT): 

 

Crop type mapping of data is performed using spectral matching techniques (P. G. Thenkabail 

2007). It will match the class spectra derived from classification with an ideal spectra-derived 

MODIS MFDC based on precise knowledge of land use from specific locations. 

SMTs are innovative methods of identifying and labeling classes. For each derived class, this 

method identifies its characteristics over time using MODIS time-series data. NDVI time-series 

(Biggs 2006, P. S. Thenkabail 2005 and V. Dheeravath 2009) are analogous to spectra, where 

time is substituted for wavelength. The principle in SMT is to match the shape, or the magnitude 

or both to an ideal or target spectrum (pure class or “end member”). The spectra at each pixel to 

be classified is compared to the end-member spectra and fit is quantified using the following 

SMTs (P. G. Thenkabail 2007); (1) spectral correlation similarity – a shape measure; (2) spectral 

similarity value (SSV) - a shape and magnitude measure; (3) Euclidean distance similarity (EDS) 

- a distance measure; and (4) Modified spectral angle similarity (MSAS) - a hyper angle 

measure. The first two SMTs are used very often (P. G. Thenkabail 2007). We have used 

Spectral similarity value (SSV) for our study. 

Spectral matching techniques (SMTs) match the class spectra derived from classification with an 

ideal spectra-derived from MODIS MFDC (Mega file data cube) based on precise knowledge of 

land use from specific locations.  SMTs, the class temporal profiles (NDVI curves) are matched 

with ideal temporal profile (quantitatively based on temporal profile similarity values) to group 

and identify classes. 
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The ideal NDVI curves for different classes of land use 

 
                                                                           Figure 10: Ideal NDVI curves 
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RESULTS AND DISCUSSIONS 
 

 

Figure 11: Study Area Classification 
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 The results include the classification and the amount of land under classification. 

CLASSES 

AREA 

(Hectares) 

Unclassified 0 

WATER BODIES /WETLANDS 28079.2 

SC RAINFED COTTON 33708.9 

SC RAINFED COTTON & OTHER CROPS 20143.7 

SC RAINFED RICE 175499 

SC IRRIGATED SW/GW RICE 273954 

SC RAINFED RICE AND OTHER CROPS 202905 

SC RAINFED RICE,COTTON & OTHER CROPS 320258 

DC IRRIGATED SW/GW RICE& OTHER CROPS 92835.9 

FOREST AND SHRUBLANDS 412283 

FOREST 470641 

SHRUBLANDS 115588 

BUILTUP 18245.9 

TOTAL 2164141.6 

    

 SC- SINGLE CROP; DC- DOUBLE CROP; SW- SURFACE WATER; GW- GROUND WATER 

Table 12: Amount of land under classification 

 During the process of classification, we have observed some croplands in the two classes 

namely Forests and Shrublands, Shrublands because of MODIS 250m imagery. 

 Due to large pixel area, we have considered the major part of the class and placed in 

respective class. 

 We have observed the major patches of cotton cropland in Rayagada and Kalahandi 

districts in certain classes. But in Balangir district the cotton crops are mixed with rice 

areas so we identified that particular classes and regrouped into SC Rainfed Rice, Cotton 

and other crops. 
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CONCLUSIONS 
 

       Monitoring of cotton croplands in Odisha using geospatial tools is done. Based on the results 

obtained from the classification, the following conclusions are drawn: 

 Most of the cotton croplands are growing in the areas of black soil and near to the river 

basins. 

 From the increased cotton area in 2013-14 kharif, obtained from LULC analysis, it had 

been concluded that there has been a development in cotton production. 

 We have observed good quality and yield of cotton is growing in Rayagada district due to 

favorable conditions for cotton and the marketing channel was well shaped. 

 Kalahandi region is the center of the study area and major growers of cotton. This district 

is facing problems in marketing and processing. So, government should focus on both by 

establishing CCI yard and Cotton processing industry. 

 We have studied the development of cotton cultivation before and after the introduction 

of Bt varieties. 

 The percentage increase of cotton crop land from 2006-07 to 2013-14 as follows. 

Balangir- 100% 

Kalahandi- 168% 

Rayagada- 157% 

 There is a slight increase in the cotton growing lands in the remaining districts every 

year.  

  Implementations of the government programmes are more important in adopting the new 

cropping systems. Instead of having agricultural diversification as a programme, it should 

be a part of agricultural planning. 

                   The overall study had a positive impact on the farmers of these districts from 

a static rice oriented cropping system to high diversified income generating cotton 

cropping system. Increase in subsidies and more financial support to the small-scale 

farmers will help them to show interest in high income generating crop like cotton.  
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